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TM-D4000 Automation - Introduction
The TM-D4000 Automation Software for PC (referred to in this manual as "the automation
software", or simply "the software") is a sophisticated and powerful software package
designed to automate the TASCAM TM-D4000 digital mixing console with a personal
computer.  This software provides time code synchronized write and read of many TM-D4000
features, including fader levels, panning, cuts, EQ and Aux. Send levels.  Automated mixing
is a powerful tool for creativity and is well suited for repetition of tedious mechanical tasks
so that listening can be more productive.

A Mixer View shows the positions of the faders, knobs and switches, where you can see the
mix as it happens as well as see the position of all the faders at a glance without switching
fader layers on the mixer itself.  A clear indication of channel names, edit modes, cut status
and group assignment with a large time code display provide critical information at a glance.

The Equalization View provides a graphical view of the channels' EQ settings, which can be
changed from the TM-D4000 or from the software.

Two Aux. Send Views show the Aux. Send levels (and pan setting for stereo linked sends) for
16 channels per view.

The TM-D4000's six Aux. Send masters, eight Buss masters, two stereo returns and stereo
master fader are all automated and shown on screen.

Mixes are held in the computer memory and then saved to disk.  The software allows you to
create different mixes quickly, listen to them, compare them, retrieve and modify them.

1.1 About This Manual
The following naming conventions will be used in this manual:
ALL CAPS will be used to indicate physical buttons or keys on the TM-D4000.
ITALIC CAPS wil be used to indicate buttons or check boxes in the LCD display of the
TM-D4000.
First Letter Caps will be used for the names of functions and modes.

This manual is organized in a functional sequence so that later instructions are dependent
upon the understanding of previous instructions.  It is recommended that this manual be
read in sequence while performing the actual functions on the TM-D4000 for better 
understanding.

1.2 Copyright
Windows, Windows 95, and Windows 98 are registered trademarks and Windows NT is a
trademark of Microsoft Corporation in the U.S. and other countries.  All other trademarks
are owned by their respective owners.

© 1999 TEAC Corporation, Inc. 1



Setup

2.1 Windows Skills Required
This manual assumes that you already possess basic Windows operating skills (pointing,
clicking, dragging, menus, dialogs, etc.  If you have just purchased your first PC for the
purposes of automating the TM-D4000, we recommend that you first read the introductory
manuals that came with your computer before starting to use the automation system.

2.2 System Requirements
In order to use the TM-D4000 automation software, your system must meet the following
requirements:
· Running Windows 95 or Windows 98
· 233 mHz or better Pentium II processor.
· 32 MB or more of RAM (64 MB recommended)
· Display of at least 1024 x 768 resolution
· Available ISA slot for the installation of the Moxa CI-132 card
· The Moxa CI-132 high-speed RS-422 board supplied with the TM-D4000 must be installed.

The software requires about 5 MB of disk space, in addition to any disk space you will use for
storing mixes.

NOTE:  The software does not run under Windows 3.1 or any version of Windows NT.

To use this software you must use the special 9-pin cable supplied with the TM-D4000.  This
cable is connected to one of the ports of the Moxa CI-132 RS-422 board also supplied with
the TM-D4000.  A standard serial cable will not work.

NOTE:  You cannot use the standard RS-232 serial port of your PC.  You must use a Moxa
CI-132 board as supplied with the TM-D4000.  If you are going to run the software on more
than one computer, you must purchase another card from Moxa Technologies or their
representatives in your country.  See http://www.moxa.com for details

2.3 Upgrading the TM-D4000 Firmware
The TM-D4000 must be running system firmware version 1.10 or higher to run the automation
software.  To check the firmware version on your mixer, press OPTION until the Setup screen
appears then press DIRECT.

Please refer to section 10-8 of the TM-D4000 Owner's Manual for complete instructions on
upgrading the firmware which can be downloaded from the TASCAM web site at
http://www.tascam.com
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Setup

2.4 Computer Hardware Installation
Before installation of the Moxa CI-132 card into a PC, set switches and jumpers as
shown in the diagram below.

JP1
ON

1 2

ON

1 2

MOXA

SW1: ON (default)

SW2: OFF

JP1: OPEN (default)

JP3: OPEN (default)

JP4: OPEN (default)

1. Install the Moxa CI-132 card that was supplied with the TM-D4000 into an open ISA
slot in your computer.  Be sure the computer’s power is turned off when you install the
card!

2. Turn on the computer’s power.  Insert the Device Driver diskette that was included
with the Moxa card.  Make a folder labeled “MOXA” in the Program Files folder of
your computer and copy the contents of the diskette into the MOXA folder you just
created.

3. Remove the diskette from the computer and store it in a safe place.
4. Inside the MOXA folder on your computer double click the file “IO-IRQ.exe”.  The IO-

IRQ screen will be displayed.  Select “Smartio/Industio ISA Family” (it should already
be selected with the other option being grayed out) and press Enter on the
computer keyboard.

5. At the bottom of the screen you will be prompted to {Enter the “Configuration
Access Port” in HEX:}.  Type in 180 and press Enter.

6. The “CI-132 series” box should be displayed.  Use the cursor keys on your computer to
navigate through the parameters and set them as shown below.  It is possible that
nothing will need to be changed.

Port index 1 2
I/O address (HEX) 180 188
IRQ 10 10
Speed 	 High 	 High
INT vector (HEX) 1c0 1c0

7. Press the F10 key to save the settings and finish the hardware installation.

3



Setup

2.5 Computer Software Installation
1. Inside the MOXA folder on your computer run the program “Setup95” to install the

device driver for the Moxa card.  After the driver has been installed the “Moxa
Configuration Panel” is displayed.

2. Click the “Add” button and the “Property” Window will appear.  Set the parameters
as shown below.

Board Type: CI-132 Series
INT Vector: 1C0 (Check Box = Checked)
Interrupt No: 	 10
Base I/I Port Address: 	 180

3. Leave everything else unchanged and click OK to close the Property window.  Then
click OK to close the Moxa Configuration Panel and display a window asking if you
want to restart the computer.  Click on the Yes box to restart.

4. When the computer has restarted insert diskette #1 of the TM-D4000 automation
software and run setup to install.  Insert diskette #2 when prompted.

5. The installation software will prompt you when the installation is finished.  It is not
necessary to restart the computer after installation of the TM-D4000 automation
software.

2.6 TM-D4000 Connection and Configuration
1. Connect the special 9-pin cable supplied with the TM-D4000 to either port on the

MOXA card on one end and connect the other end to the TO HOST port on the back
of the mixer.  You must use this supplied cable, a regular 9-pin cable will not work.

2.
 

Connect a cable from the SMPTE time code output of your recording device to the
TC In connector on the back of the TM-D4000.

3. In the Automation Setup screen of the TM-D4000 set Communication Speed to HIGH
 

4

and SYNC SOURCE to TC IN.

If you are using external time code with the TM-D4000, especially if the time code
source is unstable, you may want to increase the FLYWHEEL setting to allow the auto-
mation to proceed even when there is a timecode dropout of up to one second.

Alternatively, the internal timecode 
generator of the TM-D4000 may be used as 
the timecode source for the system.
In this case MTC will be output from the
MIDI OUT port on the back of the mixer
which could be used by a sequencer or
hard disk recorder without SMPTE capability.
It will be necessary to select both the desired
frame rate and start time.

MTC as a SYNC SOURCE is not supported in this version of the automation software.



Software Overview

3.1 Launching the Software

1. Double click the TMD4000.exe icon (or the shortcut on the Desktop or Start Menu),
and the program will launch.  The program will automatically detect what port has
been used.

2. When the TM-D4000 is detected, the program will show a graphical representation of
the current status of the following components of the mixer:

 Faders
 Pan positions
 Cut and fader groups
 Solo status
 Cut status

If the TM-D4000 is not connected correctly, 
or is not powered up, the program will display
this dialog box to abort or try again.

The TimeCode.exe program cannot be launched 
independently of the TMD4000.exe file.
If you try to launch it independently,
this error box will appear:

3.2 Timecode Window
The Timecode window must be launched from
the Mixer View by pressing <ctrl>T.  When
launched, the timecode window always
floats above other screens allowing easy access
at all times.

Timecode window floating can
be disabled if desired from the drop-down
menu accessed here.
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Software Overview

3.3 Control Bar
The Control Bar appears at the top of the main window, and contains controls and displays
that are basic to the automated mix process.  These controls appear "pushed in" when 
active, except for the F.SENSE button, which is a three-state button as described below. 

Auto Punch In and Auto Punch Out are not supported in this version of the
automation software.

Auto TakeOver allows the fader to automatically switch back to Read Mode
after an update when the physical fader passes back through its original 
position, called the "Update Reference Point".

When Auto Read is active, any channel(s) in Write or Update Mode will
automatically revert to Read Mode when the received timecode stops.

This three-state switch changes between the following three Fader Sense Modes 
which correspond to the equivalent settings make in the TM-D4000's Automation
Setup screen:
Off:  Shown by the gray F.SENSE mode.
Auto Manual:  Shown by the gray "pushed in" A.MANUAL mode.
Auto Write:  Shown by the red A.WRITE mode.
Please refer to the sections 5.2 and 5.3 on Auto Write and Auto Manual for
detailed descriptions of these functions.

This "meter" shows the amount of RAM available on your computer for further
mix moves.  The indicators light in order from left to right (green to red).
When the two right-most red indicators are lit, no further mix moves can be
written.

Activate this to enter Write Mode (the equivalent to pressing the WRITE key on
the TM-D4000).  Double click it to select Write Mode for all channels.

Activate this to enter Update Mode (the equivalent to pressing the UPDATE
key on the TM-D4000).  Double click it to select Update Mode for all channels.

6



Software Overview

Activate this to enter Read Mode (the equivalent to pressing the READ key on
the TM-D4000).  Double click it to select Read Mode for all channels.

Activate this to enter Manual Mode (the equivalent to pressing the MANUAL
key on the TM-D4000).  Double click it to select Manual Mode for all channels.

Brings up the Automation Items window which allows the selection of the 
different mixer parameters which may be automated.

Use these four buttons for the quick enabling/disabling of writing and reading
for the faders and cuts.  The red buttons on the left enable/disable writing
while the green buttons on the right enable/disable reading.

Toggles between PFL (Pre-Fader Listen) and IPS (In Place Solo).

3.4 Toolbar/Disk Operations

The Toolbar can be selected for viewing or hidden using the Show Toolbar command in the 
View Menu.  This is a floating toolbar that can be dragged from the default position and
re-anchored where most convenient.  It contains standard icons which, when clicked, carry
out file operations.

NEW:  This clears the contents of the current mix and starts a new mix session.

LOAD:  This opens the standard Windows dialog box for opening a previously saved
mix session.

SAVE:  This saves the current mix session to disk using the standard Windows dialog box.

SAVE AS:  This saves the current mix under a new name.

UNDO:  This discards the effects of the last mix pass.

REDO:  This restores mix information discarded by an UNDO command.

ABOUT:  Displays the automation software and TM-D4000 firmware versions.
7



Software Overview

3.5 Menu Items

Item Meaning

New Starts a new mix

Open Opens an existing
mix from disk

  
 

Save Saves the existing
mix to file, prompt-
ing for a file name
if one has not been
already given

 

Save as... Saves the existing
mix to another file

 

Exit Quits the software

File Menu
Item Meaning

Undo/Redo Undoes the effects
of the last timecode
pass (or redoes
them if undo has
been carried out)

Clear Initial
Status

Clears the Initial
Status, but does not
clear dynamic
events

 

Capture Initial
Status

Overwrites the cur-
rent Initial Status
with the current
console status

Clear All
Events

Clears all current
dynamic events and
Initial Status

Automation
Items...

Brings up the dialog
box where console
parameters to be
automated can be
selected

Edit Menu

8



Software Overview

Item Meaning

Toolbar Shows or hides the
toolbar

Status Bar Shows or hides the
standard Windows
status bar at the
bottom of the main
window

Hide Physical
Fader pos.

Shows or hides the
physical faders  

Timecode Starts the Timecode
program and brings
up the Timecode
controls

Automation
Setup 

Brings up the Auto-
mation Setup dialog
(equivalent to the
TM-D4000's Auto-
mation Setup 
screen)

 

Aux View (1-
16)

Brings up the
appropriate Aux
View

Aux View (17-
32)

View Menu

Item Meaning

Cascade Standard Windows
"window cascade"
function

Tile Standard Windows
"window tile"
function

List of open windows inside the appli-
cation (but not including the Timecode
bar)

Item Meaning

TM-D4000
Automation

Brings up a panel
giving the version
number of the auto-
mation software
and the ROM
installed in the
mixer

Window Menu

About Menu

9



Software Overview

3.6 Mixer View
When the automation software is launched, the Mixer View is displayed showing key
information about the automated mix including fader and knob positions, cuts, EQ
status, etc.

Group
Indicators

 If the channel is part of a fader and/or cut group, the group number is shown here
along with the group's color (fader groups are shown in the left box, cut groups
in the right

Mode Indicator This shows the mode of the channel:  Read, Write, Manual or Update.

Solo control 
and indicator

Turns red when the channel is being soloed.

EQ Control
and Indicator

Turns the equalization on and off for the channel

Cut Button Turns red to indicate that the channel is cut.

Panpot and
Indicator

Sets and shows the channel's panpot position.  The center position (as shown here)
is represented by "C".

Fader Sets and shows the channel's fader position.

Level Indicator The level of the logical fader in dB relative to nominal is displayed here.

Label Channel label.  Click here and type in up to four alphanumeric
characters. 

Channel
Number The number under the fader corresponds to the number of the TM-D4000's channel.

Stereo linked faders
are shown with a
"gang bar" linking the two
on-screen faders.

 

Logical

Physical

The Logical fader shows the true level of a channel at any moment.  This
is the fader that automatically moves during playback.

The Physical fader shows the position of the hardware fader on the
TM-D4000.  The physical fader only appears when the position of the
fader on the mixer is different from the true audio level.  When the two
are in agreement, the physical fader is concealed and the fader
is said to be "nulled".

Click the gray label
just below the level
indicator to enter a
4-character name
for the channel.

10



Settings for the TM-D4000's six Aux. Sends may be viewed and
adjusted from this screen.  These on-screen controls are available
in two different views:  Aux View (Ch01-16) and Aux View (Ch17-
32).  The Aux settings for the two ST IN inputs are shown in both
views.
Use the View menu to select either of these two views.  Note that
both views may be on the screen at the same time.
Click any of the PRE/POST or ON/OFF buttons to change these
settings.
The automation mode indicators show the current automation
mode of the channels.
The Aux. Send levels may be adjusted using the on-screen controls.
Channel labels entered in the Mixer View are shown but may not
be edited here.

Software Overview

3.7 EQ View
This is a view which allows you to view and adjust the EQ parameters for a channel.

Right-click in the fader
area of a channel.
The word "Equalizer" will
appear in a pop-up menu.

Click on this pop-up to bring the 
window shown above to the front.
The EQ button at the upper right

of the response curve can be used
to turn the EQ on or off for the

selected channel.

Alternatively, use the pull-down
list at the top of the window to

change between channels.

The on-screen rotary controls or the small up/down arrows to the right of the text boxes may be used to make
the gain, frequency and Q settings for the four EQ bands.  The graphic EQ response curve will change as the
values are changed.  The desired values could also be typed in directly.  The software will round the values
to the nearest valid value used by the TM-D4000.  Changing the EQ settings on the mixer itself will also change
the on-screen settings and the response curve.

NOTE:  Some of the controls may be disabled under certain conditions.  The Q setting has
no meaning when an HPF or LPF setting is selected in the Gain section of bands 1 and 4.

3.8 Aux Views

11



Software Overview

3.9 Automation Modes
The four automation mode keys (WRITE, UPDATE, READ and MANUAL) on 
the TM-D4000 are used in conjunction with the software to provide access 
to the automation modes described on the next page.

Automation modes can be selected for all 
channels by pressing the desired mode key 
then pressing ALL.  Automation modes can 
also be selected on a per channel basis by 
pressing a mode key then pressing ENTER to 
confirm your selection.  The indicator for the 
selected mode key will blink and individual 
channels can then be assigned to that 
mode with their SEL key.  When a mode 
indicator is blinking, another mode key can 
be selected at any time.  It is possible to 
have some channels assigned to one mode 
while other channels are assigned to a 
different mode.  A single channel can only 
be assigned to one mode at a time.

In addition to selecting these modes from the TM-D4000, you can also 
select them from the main Control Bar (See 3.3 Control Bar) by double-

clicking the desired mode button to assign all the channels to that mode.  
The appropriate indicators will light on the TM-D4000 when the mode is 

selected from the software.

TM-D4000

TM-D4000

PC

PC

“Writing”

“Reading”

Remember that the terms "write" and "read"
are relative to the mixer:  "Writing" transfers
mix moves from the mixer to the automation
software and "reading" transfers mix moves
from the automation software to the mixer.

12



Software Overview

Write Mode:
Channels in Write mode are armed and ready to write automation moves 
whenever time code is received by the automation software.  A channel 
can be punched into write mode in real time by pressing its SEL key (with 
the master mode in Write), then punched out by pressing the STOP button.  
Any time a channel is writing mix moves, switch events or POD 
adjustments it is erasing previously written information during the time the 
channel is actually in write mode, the appropriate parameters are write-
enabled and the automation software is receiving time code.

Read Mode:
Channels in Read mode will play back previously written mix moves. While 
in Read mode any fader moves, switch events or POD adjustments made 
will not be written by the automation software, nor will they affect the 
channel audio.

When reading mix moves and
listening at low volumes, it can be
helpful to turn off the motorized
faders.  The mix moves will still
be read and displayed on the
automation software screen but
the faders will not move.

Update Mode:
Update mode has three functions.  1) Changing EQ, Aux or Pan settings 
for a channel while it is reading fader automation.  2) Adding switch 
events (Cuts, EQ insertion and Aux On/Off/Pre/Post) to already existing 
switch events without replacing them.  3) Changing the overall level of a 
channel for the entire mix or a portion of it without replacing existing mix 
moves.

Manual Mode:
Channels in Manual Mode will not read or write automation data.  While 
adjustments made to a channel in Manual Mode will change the setting 
for that channel, as soon as the channel is put into Read Mode any 
changes made during Manual mode will be lost as they will be overridden 
by the automation software.

13



Building An Automated Mix

4.1 Getting Started
This section introduces important concepts and techniques relating to 
writing and editing fader moves, cuts, and other automated mix events in 
real time (while program material is playing and time code is being 
received).  Please read this section carefully as there are details to 
building an automated mix that, if skipped, will cause mix moves to be lost 
or limit the power of dynamic mix automation.

NOTE:  We will be dealing with two types of automation data:  1) Static 
data (settings that will not change during the length of the mix) and 2) 
Dynamic data (settings that will be changed by the mix moves written 
into the automation software during the mix).

You should become familiar with the 
Automation Items window available 
under the Edit Menu of the 
automation software.  It is in this 
window that it is possible to write 
enable some parameters (like faders 
or EQ) while leaving other parameters untouched.  Think of this as arming 
one track of a multitrack recorder for an overdub while leaving others in 
playback.

1.	Launch the automation software and the Time Code 
Window.  Turn off time code reception in the Time Code 
Window by clicking on the T.C. icon in the upper left corner.
2.	Set all mixer channels to Manual Mode and set up the basic mix as 
much as possible without automation. (Basic levels, panning, EQ, effects, 
etc.)
3.	Save your mix as a snapshot in the TM-D4000 as a backup.
4.	Turn on time code reception in the Time Code Window and select 
Write Mode for all channels by pressing WRITE then ALL on the Automation 
section of the TM-D4000.  Be sure that all parameters are write-enabled in 
the Automation Items window of the automation software.
5.	Under the Edit Menu of the automation software, select Clear Initial 
Status and confirm your action by clicking OK in the alert window that 
is displayed.
6.	Also under the Edit Menu, select Capture Initial Status and confirm 
your action by clicking OK in the alert window that is displayed.
7.	Play the time code from the beginning of your recording 5 to 10 
seconds before the start of audio until the readout in the time code 
window turns black.  This sets the initial static position of all settings on the 
mixer within the automation software.  Do not make any adjustments 
during this short pass.
8.	Stop the recording and select manual mode for all channels. 14



Building An Automated Mix

1.	Make the adjustments to the desired channels with those channels set 
to manual mode.  When you like the new settings, stop the recording, set 
the desired channels to write mode and select Capture Initial Status from 
the automation software Edit Menu.  (NOTE:  Only parameters that have 
been write-enabled in the Automation Items window will be saved.)
2.	The channels with new static settings can now be returned to manual 
mode for the possibility of further adjustments, or they can be placed into 
read mode to ensure that the new settings won’t get accidentally 
changed.  (NOTE:  You will always be able to make adjustments to a 
channel that is in manual mode, but those adjustments will not be saved 
until the above step is carried out.)

1.	Put desired channels into write mode, make the dynamic mix moves, 
then put the newly automated channels into read mode to play back the 
dynamic mix automation.
2.	If you wish to perform the moves again, the previous pass can be 
undone by selecting Undo from the Edit Menu in the automation software 
before attempting another pass.  Any time old mix moves are replaced by 
new ones, those channels should be in read mode before making the 
new moves to ensure starting from the same settings as before the old mix 
moves were made.  Please refer to the following section on Real Time Mix 
Editing.

4.2 Adjusting Static Settings

4.3 Creating Dynamic Mix Moves

15



Real Time Mix Editing

5.1 Manual Write
This will be the most common way to edit previously written mix moves.  
This technique is similar to punching in and out of record on a multi-track 
when doing an overdub.
·	 Channels will already be in read mode since they 
will be reading mix moves from the automation 
software.
·	 Be sure AUTO READ is checked in the Automation 
Setup screen of the TM-D4000.  This will automatically 
switch write-enabled channels to read mode when 
the recording is stopped.

1.	Write enable the channel parameters you wish to 
write in the Automation Items window of the 
software.
2.	Press the WRITE key in the Automation section of 
the TM-D4000, then confirm the selection by pressing ENTER.  The Write 
indicator on the mixer should be flashing.
3.	Play the recording a comfortable amount of time before the place 
you wish to edit mix moves.  The moving faders of the TM-D4000 will be 
following the mix moves previously written.  
4.	When it is time to begin writing new mix moves, put the desired 
channel(s) into write mode by pressing the channel’s SEL key.  As soon as 
the SEL key is pressed, the channel will begin writing mix moves, erasing 
moves that were previously written during that section of the recording.
5.	When the end of the section to be edited is reached, simply stop the 
recording to “punch out”.  All channels will automatically switch to read 
mode when the recording is stopped since the Auto Read function is 
selected.
6.	Another way to punch out is to press the READ key in the Automation 
section of the mixer, then press All to select read mode for all channels.  
This way you can continue to listen to the mix after the automation edit.
7.	It is also possible to select read mode by pressing the READ key, then 
pressing an individual channel’s SEL key to switch it to read mode.  This 
allows some channels to be punched out while other channels continue 
writing.  As long as a master mode indicator is flashing it is possible to 
switch between modes in this way with a single key press, then use the 
channel SEL keys to punch into write or out to read modes.

·	 As many channels as you need can be put into the Write or Read 
modes in this way with more channels added at any time during a mix 
pass.  However, remember that this is a dynamic mix automation system 
and you have the ability to concentrate on a few channels or just one 
channel at a time, then going on to other channels.  Just like 
overdubbing.

16



Real Time Mix Editing

5.2 Auto Write
This mode automatically puts a channel into Write Mode when a fader is 
moved.  Auto Write mode is best used for gradual fader movements while 
Manual Write is better suited for drastic or quick fader movements.

·	 Channels will already be in read mode since they 
will be reading mix moves from the automation 
software.
·	 Be sure AUTO READ is checked in the Automation 
Setup screen of the TM-D4000.  This will automatically 
switch write-enabled channels to read mode when the 
recording is stopped.
·	 Write mode does not need to be selected in the 
Automation section of the mixer.

1.	Select AUTO WRITE in the Fader Sense Mode section 
of the Automation Setup screen on the TM-D4000.
2.	Play the recording a comfortable amount of time 
before the place you wish to edit mix moves.  The moving faders of the 
TM-D4000 will be following the mix moves previously written.
3.	Begin slowly moving the desired fader(s) when you wish to edit mix 
moves.  The fader will automatically switch to write mode and begin 
writing new mix moves.
4.	When the end of the section to be edited is reached, simply stop the 
recording to “punch out”.  All channels will automatically switch to read 
mode when the recording is stopped since the Auto Read function is 
selected.

·	 Another way to punch out is to press the Read key in the Automation 
section of the mixer, then press All to select read mode for all channels.  
This way you can continue to listen to the mix after the automation edit.

·	 It is also possible to select read mode by pressing the Read key and 
confirming the selection with the Enter key, then selecting read mode on 
the desired channels by pressing the SEL key.  This allows some channels to 
be punched out while other channels continue writing.

·	 Since the read mode stays selected it is possible to punch into write 
mode on a channel by moving its fader, then punch out to read mode 
simply be pressing the channel’s SEL key.  This can be repeated as many 
times as necessary on as many channels as necessary.

17



Real Time Mix Editing

5.3 Auto Manual
This mode automatically puts a channel into manual mode when a fader 
is moved.  This can be useful for experimenting with new mix moves 
without erasing previous ones.  Remember, manual mode does not write 
mix moves, so these experiments will not be written to the automation 
software.  Also, when a channel is switched to manual mode, all the 
parameters of that channel will stop reading mix moves.  So if you 
experiment with fader moves on a channel that has panning moves 
written, the panning moves will stop playing back.

·	 Channels will already be in read mode since they will be reading mix 
moves from the automation software.

1.	Select AUTO MANUAL in the Fader Sense Mode 
section of the Automation Setup screen on the TM-
D4000.
2.	Play the recording a comfortable amount of time 
before the place you wish to experiment with mix 
moves.  The moving faders of the TM-D4000 will be 
following the mix moves previously written.
3.	Begin moving the desired fader(s) when you wish 
to begin experimenting with mix moves.  The 
channel will automatically switch to manual mode.
4.	When the end of the experiment is reached, 
simply stop the recording or switch back to read mode using the READ 
and ALL keys for all channels or the READ and SEL keys for individual 
channels.

·	 In this mode Auto Read will not switch all channels to Read Mode 
when the recording is stopped, allowing further experimentation when the 
recording is started again.  It is necessary to manually switch back to 
Read Mode when desired.

NOTE:  Since Auto Write and Auto Manual will cause a channel to go into 
Write or Manual mode when a fader is moved, turn these functions off 
before the final mixdown.  If a fader is accidentally moved with one of 
these functions on, that channel will stop playing back mix moves, and in 
the case of Auto Write, that fader will begin erasing mix moves.
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Updating Mix Moves

6.1 Adjusting POD Settings

Update mode provides access to some of the more powerful and 
important features in the dynamic automation software.  Using Update 
Mode it becomes possible to adjust POD settings for a channel while 
reading fader moves, add switch events without replacing existing ones 
and change the overall level of a channel for a section of the recording 
or the entire mix while retaining already written mix moves.

During the process of mixing it is common practice to make adjustments 
to EQ, Aux. Sends, Panning, etc. while listening to other mix parameters 
being read.  In this way we can more accurately make the critical sonic 
judgements required during a mixdown.  (NOTE:  Update Mode must be 
used for this purpose since Read Mode accepts mix moves only from the 
automation software, not from the mixer’s controls.)

By following the steps below it is possible to make changes to the static 
settings of one parameter (EQ for example) while listening to dynamic 
moves being read by other parameters (fader, panning, etc.)

1.	In the Automation Items window of the automation software, uncheck 
WRITE ENABLE for all parameters.
2.	In the case of EQ it can be useful to store the pre-adjustment setting in 
an EQ library in case the original setting is preferred over the adjusted 
setting.
3.	Select Update Mode for the channel(s) you wish to make adjustments 
to by pressing UPDATE in the AUTOMATION Section of the TM-D4000, then 
selecting the desired channels using their SEL key.  Update mode for a 
channel can also be selected while the recording is playing.
4.	While in Update Mode it is possible to freely adjust the desired 
parameter while the recording is playing.  If the recording ends or is 
stopped and the adjustment has not been completed, it is then necessary 
to WRITE ENABLE only the adjusted parameter in the Automation Items 
window of the software, select Write Mode on only the adjusted channels 
with the recording stopped, then select Capture Initial Status under the 
Edit menu of the automation software.  If it is more desirable to begin the 
adjustment again from the original setting, simply play the recording 
again and it will be restored.  However, once Capture Initial Status has 
been performed it will be necessary to recall the original setting from your 
stored library. 19



Updating Mix Moves

6.2 Adding Switch Events
There may be times during a mix that it is needed to add a switch event or 
events (a Cut, EQ switch or Aux Send switch) so close to an existing good 
switch event that Write Mode might accidentally erase the good switch 
event.  In these instances Update Mode may be used to add the new 
switch event(s) without the danger of erasing existing ones.  Or you may
simply wish to experiment with some different cuts.

1.	In the Automation Items window of the automation software WRITE 
ENABLE only the parameters where switch events are to be added.  (CUT, 
EQ and/or AUX)  NOTE:  EQ and AUX also have dynamic controls in 
addition to switches that will be write-enabled.  Update Mode will not 
erase previously written mix moves on the dynamic controls.  However, if 
they are adjusted during Update Mode the result will be the same as if the 
adjustment were made during Write Mode.
2.	Select Update Mode for the channel(s) you wish to add switch events 
to by pressing UPDATE in the AUTOMATION Section of the TM-D4000, then 
selecting the desired channels using their SEL key.  Update Mode for a 
channel can also be selected while the recording is playing.
3.	Add switch events as desired.  If you wish to try again, select Undo from 
the Edit Menu of the automation software before playing the recording 
again.

·	 The status of the dynamic processor insertion switch can be freely 
changed in Update Mode and will remain on or off as selected since this 
switch event is not written or read by the automation software.

6.3 Making Relative Offsets to Fader Moves

Original write
level (pass 1) End of

write

Trim

Update (pass 2) End of update

Resulting
level after
update

During a mix there may be sections where there 
are good mix moves on a channel but the overall 
volume of the section needs to be raised or 
lowered.  In these instances Update Mode can be 
used to make relative offsets to fader moves 
without erasing the existing mix moves.

1.	In the Automation Items window of the 
automation software check the box to WRITE 
ENABLE faders.  You may wish to uncheck the 
WRITE ENABLE boxes for the other parameters to 
avoid writing an unwanted mix move or switch event.
2.	Select Update Mode for the channel(s) you wish to make relative 
offsets to by pressing UPDATE in the AUTOMATION Section of the TM-D4000, 
then selecting the desired channels using their SEL key.  Update Mode for 
a channel can also be selected while the recording is playing.
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Updating Mix Moves

6.4 Auto Takeover

3.	Play the recording a comfortable amount of time before the place 
you wish to begin offsetting fader moves.  The faders on the TM-D4000 will 
be following the mix moves previously written.  When a channel is placed 
into Update Mode, its fader will stop moving and be represented by the 
Physical fader on the automation software screen.  The Logical fader on 
the software screen will continue to move, reading mix moves and 
controlling the actual volume of the channel.
4.	As soon as a channel is placed into Update Mode an Update 
Reference Point (a small yellow arrow) will appear next to the Physical 
fader on the automation software screen.  When the physical fader is 
moved above the Update Reference Point, you are increasing the level of 
previously written moves.  When the Physical fader is moved below the 
Update Reference Point, you are decreasing the level of the previously 
written moves.
5.	When the section needing the relative offset is finished, punching out 
of update can be done in any of the ways described in section 5.1, 
Manual Write.

·	 To create a seamless transition from the relative offset to the section of 
the recording that comes after, return the physical fader to match the 
Update Reference Point before punching out.  This will also only add the 
relative offset to the actual edited section of the recording.
·	 If the physical fader is left above or below the Update Reference Point 
when punching out of Update, then the relative offset will be kept from 
the beginning of the offset until the end of the recording.

Auto Takeover is a convenient feature that is used within Update Mode for 
a seamless transition from the offset to the remaining portion of the 
recording.  With a standard Update it is 
possible to offset mix moves above and below 
the Update Reference Point in one pass.  With 
Auto Takeover enabled the relative offset can 
only be added above or below the Update 
Reference Point in one pass.  The channel will 
automatically switch back to Read Mode 
when the Physical fader passes back through 
the Update Reference Point.
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